Participating/Cooperating Agencies
A During the PD&E Process:
Planning Organizations and Lead Agencies




Definition: Participating Agency

Pursuant to Section 6002 of SAFETEA-LU, participating agencies are responsible to identify, as early
as practicable, any issues of concem regarding the project's potential environmental or socioeconomic
impacts that could substantially delay or prevent an agency from granting a permit or other approval that
is needed for the project. Federal, state, tribal, regional, and local govemment agencies that have an
interest in the project can be participating agencies.

Pursuant to Section 1305 of Map-21 each participating agency shall cary out the obligations of that
agency under other applicable law concurrently, and in conjunction, with the review required under the
National Environmental Policy Act of 1969 (42 U.S.C. 4321 et seq.), unless doing so would impair the
ability of the Federal agency to conduct needed analysis or otherwise carry out those obligations; and
formulate and implement administrative, policy, and procedural mechanisms to enable the agency to
ensure completion of the environmental review process in a timely, coordinated, and environmentally
responsible manner.

The designation of participating agency does not imply that your agency supports the proposed project;
has any jurisdiction over, or special expertise with respect to evaluation of the project




Definition: Cooperating Agency

According to the Council on Environmental Quality (CEQ) (40 CFR 1508.5), cooperating agency
means any federal agency, other than a lead agency, that has jurisdiction by law or special expertise
with respect to any environmental impact involved in a proposed project or project altemative. A State or
local agency of similar qualifications (or when the effects are on lands of tribal interest, a Native
American fribe) may, by agreement with the lead agency, also become a cooperating agency.
Cooperating agencies have a higher degree of authority, responsibility, and involvement in the
environmental review process than participating agencies. Because the cooperating agencies have
legaljurisdiction requirements tied to the preparation of the Environmental Document they may be
called upon to review the pre-circulation Environmental Document on a case by case basis by the lead

agency.

The standard for participating agency status is more encompassing than the standard for cooperating
agency status. Therefore, cooperating agencies are, by definition, participating agencies, but not all
participating agencies are cooperating agencies.

Pursuant to Section 1305 of Map-21 each cooperating agency shall carry out the obligations of that
agency under other applicable law concurrentty, and in conjunction, with the review required under the
National Environmental Policy Act of 1969 (42 U.S.C. 4321 et seq.), unless doing so would impair the
ability of the Federal agency to conduct needed analysis or otherwise carry out those obligations; and
formulate and implement administrative, policy, and procedural mechanisms to enable the agency to
ensure completion of the environmental review process in a timely, coordinated, and environmentally
responsible manner.




Process Overview

¢ This process:

* |dentifies engagement during the PD&E Process
for federal projects

* Depends on the project specifics
* Depends on the approved Class of Action (COA)
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District: District 3

County: Leon

Planning Organization: FDOT District 1

Plan ID: Not Available

Federal Involvement: Federal Funding
Contact Information: Name: tester tester

Phase: Programming Screen

From:

To:

Financial Management No.: Mot Available

E-mail: test-FD1-tester fecp-ou3943@devnull.fla-etat.org
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Lead Agencies
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Planning Organization Tasks

¢ Making Recommendations and Responding to
Requests

¢ Sending Recommendations to the Lead Agency
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| Lead Agency ” Participating and Cooperating Agencies

Participating and Cooperating Agency Roles

Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertise:

# Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of
detail required in the alternatives analysis.

» Participate in coordination meetings and joint field reviews as appropriate.

» Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adeguacy of the
document, alternatives considered, and the anticipated impacts and mitigation.

These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.

Cooperating Agencies

Use the tools in the Recommend an Agency section below to recommend cooperating agencies

There are no cooperating agencies for this project.

Participating Agencies
Use the tools in the Recommend an Agency section below to recommend participating agencies

There are no participating agencies for this project.

Recommend an Agency
Select an agency and click the Add button to add a new recommendation

FL Department of Agriculture and Consumer Services ~ Add

FL Department of Agriculture and Consumer Services
FL Department of Environmental Protection

@w FL Department of State

FL Fish and wildlife Conservation Commission

Miccosukee Tribe of Indians of Florida

National Marine Fisheries Service
National Park Service

Seminole Tribe of Florida

US Army Corps of Engineers

US Coast Guard

US Environmental Protection Agency
US Fish and Wildlife Service

Click to Open Map
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Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertize:
Document Review = e Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of
detail required in the alternatives analysis.
® Participate in coordination meetings and joint field reviews as appropriate.
& Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the
document, alternatives considered, and th= ="_+i"i"=*°f‘ imnacte and e
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Participating Agencies
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There are no participating agencies for this project.
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‘ Lead Agency H Participating and Cooperating Agencies

Participating and Cooperating Agency Roles

Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertise:

* Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of
detail required in the alternatives analysis.

® Participate in coordination meetings and joint field reviews as appropriate.

& Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the
document, alternatives considered, and the anticipated impacts and mitigation.

These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.

Cooperating Agencies
Use the tools in the Recommend an Agency section below to recommend cooperating agencies

Action

Agency Request Recommendation

Cooperating (Chris T. Sands pending)
This project has direct impact on National
Marine Fisheries. After discussion with the
ETAT Members at NMFS, we have
condluded that their imvolvement as a
cooperating agency is appropriate.

National Marine Fisheries Service

Participating Agencies
Use the tools in the Recommend an Agency section below to recommend participating agencies

There are no participating agencies for this project.

Recommend an Agency
Select an agency and click the Add button to add a new recommendation

FL Department of Agriculture and Consumer Services =

(?l'lu'laiting for programming screen review to complete

Click to Open Map
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Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertise:
® Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and lewvel of

& Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the

Per agency agreement, projects with bridges over navigable waterways and FHWA as the lead agency should include the U.5. Coast Guard as a

Click the Respond or Change buittons to modify your recommendations to the Lead Agency for inviting cooperating agencies

Recommendation

Action

1 Donec facilisis sapien a mi sagittis molestie
1 eget ut est. Aliquam erat volutpat. Nullz id

Cooperating Agency (Bill Beers pending)

Aliguam erat volutpat. Nulla id ligula massa,

et varius quam. Aenean sit amet lorem
tortor.

Cooperating Agency (Bill Beers pending)

ligula massa, et varius quam. Aenean sit

amet lorem tortor

modify your recommendations to the Lead Agency for inviting pariicipating agencies

Recommendation

Action

Commission

Participating Agency (Bill Beers pendiing)

et varius quam. Aenean sit amet lorem
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Review Project = District: District 3 Phase: Programming Screen Contact Information: tester tester
Community Coordination =
Coordinate ETAT » | Lead Agency H Participating and Cooperating Agencies
Performance Management =
RO e Participating and Cooperating Agency Roles
Project Tracker =
Document Review =
detail required in the alternatives analysis.
& Participate in coordination meetings and joint field reviews as appropriate.
document, alternatives considered, and the anticipated impacts and mitigation.
These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.
cooperating agency.
Cooperating Agencies
Agency Request
FL Department of Agriculture and Consumer :
Services i
i
| Cooperating Agency (ETAT Member
| Test 09/22/2012)
1 Lorem jpsum dolor sit amet. consectetur
| adipiscing elit. Vivamus tempor luctus
National Marine Fisheries Service » faucibus. Donec malesuada Justo ac quam
| sodales ac dapibus madris mattis. Nullam
| varius tempor turpis 8 consequat. Proin
» tincidunt justo vel metus bibendum fringilia.
| Sed at nisi justo, non elementum sem.
Participating Agencies
Reports v
4 Click the Respond or Change buitons to
Wizards w E > :
Maps v Agency Request
Account Settings v :
. ; FL Fish and Wildlife Conservation
Administration v :

Fmrdor

Aliguam erat volutpat. Nulla id ligula massa,

1

Click to Open Map
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foje fary document, alternatives considered, and the anticipated impacts and mitigation.
Advance Notification Package = These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.
Review Project = Per agency agreement, projects with bridges over navigable waterways and FHWA as the lead agency should include the U.5. Coast Guard as a
: e cooperating agency.
Community Coordination =
Coordinate ETAT = m m
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Performance Management =
Agency Invoices > Click the Respond or Change buttons to modify your recommendations to the Lead Agency for inviting cooperating agencies
Project Tracker = Agency Request Recommendation Action
Document Review = ! Cooperating Agency (Bill Beers pending)
FL Department of Agriculture and Consumer : 1 Aliquam erat volutpat. Nulla id ligula massa,
Services 1 1 et varius quam. Aenean sit amet lorem H
} ) tortor. !
I 1 1
! Cooperating Agency (ETAT Member
| Test 09/22/2012) ; ;
1 Lorem jpsum dolor sit amet, consectetur 1 Cooperating Agency (Bill Beers pending) :
© adipiscing efit. Vivamus termpor luctus 1 Donec facilisis sapien a mi sagittis molestie !
Mational Marine Fisheries Service | faucibus. Donec malesuada justo ac quam | eget ut est. Aliguam erat volutpat. Nulla id
| sodales ac dapibus mauris mattis. Nullam ligula massa, et varius quam. Aenean sit |
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Help w
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# Participate in coordination meetings and joint field reviews as appropriate.
# Timely review and comment on the pre-draft or pre-final environmental documents to reflect the wiews and concerns of your agency on the adequacy of the

document, alternatives considered, and the anticipated impacts and mitigation.
These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.

Per agency agreement, projects with bridges over navigable waterways and FHWA as the lead agency should include the U.S. Coast Guard as a

cooperating agency.

Cooperating Agencies

Click the Respond or Change buttons to modify your recommendations to the Lead Agency for inviting cooperating agencies

Agency

i Request

Recommendation

: Action

FL Department of Agriculture and Consumer

Services

National Marine Fisheries Service

Participating Agencies

Click the Respond or Change buttons

Agency

FL Fish and Wildlife Conservation
Commission

Confirm Send

: Cooperating Agency (Bill Beers pending)
1 Aliguam erat volutpat. Nulla id ligula massa,
\ et varius quam. Aenean sit amet lorem

! tortor.

A notification will be sent to the lead agency that they may proceed
to send their own invitations, as needed. If you need to make
changes to the recommendation list after submitting this form,

please contact the help desk.

. Send Recommendations || Cancel ‘

i Aliquam erat volutpat. Nulla id ligula massa,
» et varius quam. Aenean sit amet lorem

y (Bill Beers pending)
en & mi sagittis molestie
7 erat volutpat. Nulla id
rius quam. Aenean sit

rinviting participating agencies

nmendation Action

¥ (Bill Beers pending)

Recommend an Agency

Select an agency and click the Add button to add a new recommendation

FL Department of Environmental Protection

= Add

Send Recommendations

Click the button below when you are ready to send recommendations to the Lead Agency

[ Send Recommendations

@Programming screen review is complete; waiting for planning organization to make and send recommendations

I

Click to Open Map
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Participating and Cooperating Agency Roles

Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertise:

* Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of

detail required in the alternatives analysis.
® Participate in coordination meetings and joint field reviews as appropriate.

& Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the

document, alternatives considered, and the anticipated impacts and mitigation.

These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.

Cooperating Agencies

Agency ' Request ' Recommendation ' Invitation

! Cooperating Agency (Bill

i ' Beers 10/21/2012)

H Deineit .mc Pl o : | Aliguam erat voluipat. Nulla id ligula
Consumer Services ' I i : '
! | massa, et vanius guam. Aenean sit !

» amet lorem tortor.

! Cooperating Agency (ETAT Member |

| Test 09/22/2012) 5 5

| Lorem [psum dolor sit amet. | Cooperating Agency (Bill :

| consectetur adipiscing efit. Vivermus | Beers 10/21/2012) !

» tempor luctus faucibus. Donec » Donec facilisis sapien & mi sagittis

National Marine Fisheries Service | malesuada juste ac quam sodales ac | molestie eget ut est, Aliguam erat :
| dapibus mauris mattis. Nullam varius | volutpat. Nulla id ligula massa, et !

» termpor turpis & consequat. Proin L varius quam. Aenean sit amet lorem

 tincidunt justo vel metus bibendum | tortor

| fringilla. Sed at nisi justo, non £ !

© elementum sem.

Participating Agencies
Agency Request : Recommendation : Invitation

FL Fish and Wildlife Conservation
Commission

' Participating Agency (Bill

| Beers 10/21/2012)

» Aliguam erat volutpat. Nulla id ligula
massa, et varius quam. Aenean sit

» amet lorem tortor.
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Click to Open Map




Email Notification to Lead Agency

Chris T. Sands, on behalf of FDOT District 1, makes the following recommendations for participating and cooperating agencies for ETDM Project #12657.

ETDM #: 12657
PROJECT NAME: PCI Testing-—Issue 6

Participating agencies:

FL Fish and Wildlife Conservation Commission
Rationale for recommendation: Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorem tortor.

FL Fish and Wildlife Conservation Commission did not request to serve as a participating agency.

Cooperating agencies:

FL Department of Agriculture and Consumer Services
Rationale for recommendation: Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorem tortor.

FL Department of Agriculture and Consumer Services did not request to serve as a cooperating agency.

National Marine Fisheries Service

Rationale for recommendation: Donec facilisis sapien a mi sagittis molestie eget ut est. Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorel

A request by ETAT Member Test, on behalf of National Marine Fisheries Service, to serve as a cooperating agency was sent on 09/22/2012.

Rationale for request: Lorem ipsum dolor sit amet, consectetur adipiscing elit. Vivamus tempor luctus faucibus. Donec malesuada justo ac quam sodales ac dapibus maur

mattis. Nullam varius tempor turpis a consequat. Proin tincidunt justo vel metus bibendum fringilla. Sed at nisi justo, non elementum sem.

As the lead agency, Federal Highway Administration is responsible for officially inviting and approving participating and cooperating agencies. These roles should only be considered f

proposed Environmental Assessments or Environmental Impact Statements.

Please send any desired invitations within 30 calendar days. If vou do not wish to invite any agencies as cooperating or participating, please use the invitations interface to indicate non

invited.

Please use the following link to send invitations to participating and cooperating agencies for ETDM Project #126357-
Participating / Cooperating Invitations or log in to the EST and use the menu: Tools > Review Project = Participating / Cooperating Invitation




Email Notification to Lead Agency

No agencies invited

Participating agencies:

No agencies are recommended to serve as participating agencies.

Cooperating agencies:

No agencies are recommended to serve as cooperating agencies.

As the lead agency, Federal Highwav Administration is responsible for officially inviting and approving participating and cooperating agencies.
These roles should onlv be considered for proposed Environmental Assessments or Environmental Impact Statements.

Please send anv desired invitations within 30 calendar davs. If vou do not wish to invite anv agencies as cooperating or participating, please use th
invitations interface to indicate none are invited.

Please use the following link to send invitations to participating and cooperating agencies for ETDM Project #9514:
Participating / Cooperating Invitations or log in to the EST and use the menu: Tools > Feview Project = Participating / Cooperating Invitation




Lead Agency Tasks

+ Making Invitations and Responding to
Recommendations

¢ Sending Invitations
+ Reviewing Invitation Responses
+ Withdrawing Invitations




Making Invitations

Tools

Review Project =
Coordinate ETAT =

FPerformance Management =
Agency Invoices =

Project Tracker =

Adwance Notification Package

Purpose & Need

Project Effects

Cumulative Effects Considerations
Rewiew

Class of Action Determination

Participating / Cooperating Invitaticn
Response

Manage Participating / Cooperating

Invitations
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Participating and Cooperating Agency Roles

Cooperating and participating agency roles during the development of a project include the following as they relate to their area of expertise:

s Provide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of

detail required in the alternatives analysis.
» Participate in coordination meetings and joint field reviews as appropriate.

e Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the

document, alternatives considered, and the anticipated impacts and mitigation.

These agency roles should be considered for proposed Environmental Assessments or Envirenmental Impact Statements.

Per agency agreement, projects with bridges over navigable waterways and FHWA as the lead agency should include the U.S. Coast Guard as a

cooperating agency.

Invitations should be sent within 30 calendar days after the recommendations from Florida DOT are received.
It has been 0 days since these recommendations were sent. Please send the invitations as soon as possible.

Cooperating Agencies

Click the Respond or Change buttons to modify your invitations to cooperating agencies

Agency Request Recommendation Invitation Action

' Cooperating Agency (Bill
. : | Beers 10/21/2012) : :

H Depaviment of Funnliurs amd ! Aliguam erat volutpat. Nulla id : *
Consumer Services i g : i |
' » figula massa, et varius quarm. ' '
+ Aenean sit amet lorem tortor.
! Cooperating Agency (ETAT Member !
! Test 09/22/2012) ; ; ;
1 Lorem jpsum dolor sit amet, \ Cooperating Agency (Bill : :
| consectetur adipiscing elit. Vivamus ' Beers 10/21/2012) ; ;
» tempor luctus favcibus. Donec + Donec facilisiz sapien a mi sagittiz

Mational Marine Fisheries Service | malesuada justo ac quam sodales | molestie eget ut est. Aliguam erat | *
\ ac dapibus mauris mattis. Nullam | volutpat. Nulla id ligula massa, et
» varius tempor turpis 8 consequat. . varius guam. Aenean sit amet
! Proin tincidunt justo vel metus ! lorem tortor ! !
© bibendum fringilla. Sed at misi
» justo, non elementum sem.

Participating Agencies
Click the Respond or Change buttons to modify your invitations to participating agencies
Agency Request Recommendation Invitation Action

1 Beers 10/21/2012)

FL Fish and Wildlife Conservation ! R ok volilit: Nl i

 Participating Agency (Bill
Commission :

*
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Click to Open Map
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Coordinate ETAT = document, alternatives considered, and the anticipated impacts and mitigation.
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detail required in the alternatives analysis.
* Participate in coordination meetings and joint field reviews as appropriate.
* Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concerns of your agency on the adequacy of the
document, alternatives considered, and the anticipated impacts and mitigation.
These agency roles should be considered for proposed Environmental Assessments or Environmental Impact Statements.

Per agency agreement, projects with bridges over navigable waterways and FHWA as the lead agency should include the U.S. Coast Guard as a =

cooperating agency.

Invitations should be sent within 30 calendar days after the recommendations from Florida DOT are received.
It has been 0 days since these recommendations were sent. Please send the invitations as soon as possible.
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Email Notification sent to District
Identifies all invited agencies

Participating agencies:

FL Fish and Wildlife Conservation Commission
Rationale for invitation: Federal Highwav appreciates FEWCCs involvement as a participating agency and thinks it will bring a valuable perspective to the project.

A recommendation by Bill Beers, on behalf of FDOT District 1, for FL Fish and Wildlife Conservation Commission to serve as a participating agency was sent on 10/21/2012.
Rationale for recommendation: Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorem tortor.

FL Fish and Wildlife Conservation Commission did not request to serve as a participating agency.

Cooperating agencies:

FL Department of Agriculture and Consumer Services
Rationale for invitation: Federal Highway agrees with the rationale for designating FDACS a cooperating agency.

A recommendation by Bill Beers, on behalf of FDOT District 1, for FL. Department of Agriculture and Consumer Services to serve as a cooperating agency was sent on
10/21/2012.

Rationale for recommendation: Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorem tortor.

FL Department of Agriculture and Consumer Services did not request to serve as a cooperating agency.

Requesting and/or recommended agencies not invited:

National Marine Fisheries Service
Rationale to not invite: Federal Highway does not wish to invite NMFS as a cooperating agency.

A recommendation by Bill Beers, on behalf of FDOT District 1, for National Marine Fisheries Service to serve as a cooperating agency was sent on 10/21/2012.
Rationale for recommendation: Donec facilisis sapien a mi sagittis molestie eget ut est. Aliquam erat volutpat. Nulla id ligula massa, et varius quam. Aenean sit amet lorem tortor

A request by ETAT Member Test, on behalf of National Marine Fisheries Service, to serve as a cooperating agency was sent on 09/22/2012.
Rationale for request: Lorem ipsum dolor sit amet, consectetur adipiscing elit. Vivamus tempor luctus faucibus. Donec malesuada justo ac quam sodales ac dapibus mauris
mattis. Nullam varius tempor turpis a consequat. Proin tincidunt justo vel metus bibendum fringilla. Sed at nisi justo, non elementum sem.

These invitations will expire in no more than thirtv calendar days on Tuesday, November 20, 2012 or when all invited agencies have responded to their invitations. At that time, FDOT District
1 will be notified to proceed with a Class of Action.




Email Invitation sent to invited agency

The Federal Highway Administration (FHWA) is scoping for a Class of Action for proposed ETDM Project #12657. The purpose of the project, as currently defined, can be found within the
Environmental Screening Tool (EST) at https:/pre-prod_ fla-etat org/est/?openPage=pnR eport jsp&projectld=12657

As part of the environmental review process for this project, the lead agency must identify, as early as practicable, any other federal and non-federal agencies that may have an interest in the
project, and invite such agencies to serve as participating or cooperating agencies in the environmental review process. A cooperating agency also assumes the role of a participating agencyv as
described below. The roles and responsibilities of participating and cooperating agencies are similar, but cooperating agencies have a higher degree of authority, responsibility, and involvement
in the environmental review process (40 CFR Section 1501.6).

With this letter, we extend an invitation to FL. Department of Agriculture and Consumer Services to serve as a cooperating agency with the FHWA in the development of the Class of Action
for the subject project. FL Department of Agriculture and Consumer Services will serve as a cooperating agency in accordance with 40 CFR. 1501 .6 of the Council on Environmental Qualitv's
(CEQ) Regulations for Implementing the Procedural Provision of the National Environmental Policy Act.

Pursuant to Section 6002 of SAFETEA-LU and Section 1305 of MAP-21, participating agencies are responsible to identify, as early as practicable, any issues of concemn regarding the project's
potential environmental or socioeconomic impacts that could substantially delay or prevent an agency from granting a permit or other approval that is needed for the project. We suggest that
vour agency's role in the development of the above project should include the following as they relate to vour area of expertise:

+ DProvide meaningful and early input on defining the purpose and need, determining the range of alternatives to be considered, and the methodologies and level of detail required in the
alternatives analysis.

+ Participate in coordination meetings and joint field reviews as appropriate.

+ Timely review and comment on the pre-draft or pre-final environmental documents to reflect the views and concems of vour agency on the adequacy of the document, altematives
considered, and the anticipated impacts and mitigation.

Please respond to the invitation prior to the expiration date, Tuesdav, November 20, 2012, at the following page within the EST https:/pre-prod.fla-etat org/est/7openPage=screening%o
2FInvitationResponse doTinvitationId=75 accessible via https:/pre-prod_fla-etat.org/est Tools > Review Project > Participating / Cooperating Invitation.

Your agency must accept this invitation by the expiration date (Tuesday, November 20, 2012) to become a cooperating agency.

If vou have any questions or would like to discuss in more detail the project or our agencies' respective roles and responsibilities during the preparation of this Class of Action, please contact
the Project's ETDM Coordinator or Project Manager listed above.

Thank vou for vour cooperation and interest in this project.
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All invitations for participating and cooperating agencies for ETDM Project #12657 have received a response or have expired. FDOT District 1 can now prepare a Class of Action.

ETDM #:

PROJECT NAME:
FINANCTAL #:

FEDERAL INVOLVEMENT:
ACE PROJECT:
ALTERNATIVE:

MODES:

SIS:

DISTRICT:

COUNTY:

PLANNING ORGANIZATION:
SCREEN:

REVIEW START:

REVIEW END:

ETDM COORDINATOR:

PROJECT MANAGER:
LEAD AGENCY:
CLASS OF ACTION (COA):

Email Notifications

12657

PCI Testing—-Issue 6
Not assigned at this time
Federal Funding

N

1

Not Assigned.

N

3

Leon

FDOT District 1
Programming Screen
Sunday, 10/21/2012
Sunday, 10/21/2012

tester tester
(999) 9999999
test-FD 1-tester fecp-ou3943/@devnull.fla-etat.org

None assigned at this time
FHWA (proposed)

Not determined at this time




Define the Class of Action

Tools rFy

Create Newr Project
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Project Description

Advance Motification Package = Alternative Deseription

Review Project = Preliminary Enwirenmental Discussion
{FEL}

Draw Project on Map

Community Coardination =

Coordinate ETAT = Extract Project from State Highway
System

Perormance Management = Segment Description

Agency Invoices = Project Phase [Planning, et}

Project Status (Editing, etc.)
Attach Documents

Project Tracker =

Project Manager Information

Agency Roles in PDEAE

Commitments and Responses

Permits

Technical Studies

Class of Action
Project Schedule
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Contact Information: tester tester test-FDi-tester fecp-ou3343@devnul.fla-etat.org

Other Actions

[C] section 4(f) Evaluation
[C] Section 106 Consultation
[T endangered Species Assessment

Participating/ Cooperating Agencies

This project has a Class of Action of Categorical Exclusion (CE).

In rare cases, CE projects may have either US Army Corps of Engineers (USACE) or US Coast Guard (USCG) serve as a
cooperating agency.

CE projects do not have participating agencies.

Sands @ FDOT District 3

Save Class of Action

' Federal Highway Administration has accepted the Purpose and Need statement.

Clicking the "Save Class of Action" button will open the Review Class of Action Determination form.
You must approve the Class of Action before notification will be sent to the Federal Lead Agency.

Active project: #12657 PCI Testing—lssue & ~ Mapit
Hide << Class of Action Determination |
Tools A . . .
o Class of Action Determination
Project Diary =
Advance Nofification Package = #12657 PCI TES‘tiﬂg--ISSUE 6
Review Project = District: District 2 Phase: Programming Screen
Community Coordination = Defi the CI T Act
Coordinate ETAT = eline € asso ction
Perfarmance Management =
Agency Invoices = Class of Action
Project Tracker = _ i
. ) Environmental Assessment
Document Review = ) Environmental Impact
Statement
@ Categorical Exclusion
() State Environmental Impact
Report
) Reevaluation
Lead Agency
Federal Highway Administration
Change Lead Agency
Save the Class of Action
User Identity Chris T.
Important Messages
Reports v
Wizards v
Maps v
Account Settings v
Administration v
Haln -

Click to Open Map
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Define the Class of Action

Class of Action Other Actions

) Environmental Assessment

@ Environmental Impact Statement
) Categorical Exclusion

~) State Environmental Impact Report

[C] section 4(f) Evaluation
[ Section 106 Consultation
[T] Endangered Species Assessment

) Reevaluation

Lead Agency Participating/ Cooperating Agencies

Cooperating Agencies
Federal Highway Administration FL Department of Agriculture and Consumer Services (Accepted)
Participating Agencies

q gency ] - T ' ) .
Change Lead Agen No agencies were invited to serve as participating agencies for this project.

All invitations to agencies are complete. You may submit a Class of Action.

Save the Class of Action

User Identity Chris T. Sands @ FDOT District 3

| Save Class of Action

Important Messages
' Federal Highway Administration has accepted the Purpose and Need statement.

Clicking the "Save Class of Action" button will open the Review Class of Action Determination form.
You must approve the Class of Action before notification will be sent to the Federal Lead Agency.

Click to Open Map
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Project Effects

Cumulative Effects Considerations
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Participating / Cooperating Inwvitation
Response

Manage Participating / Coocperating
Invitations
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Active project: #12657 PCI Testing-lssue & + Mapit Environmental Screening Tool

Tools
Project Diary =
Advance Notification Package =
Review Project =

Community Coordination =
Coordinate ETAT =
Perfarmance Management =
Agency Invoices =

Project Tracker =

Document Review =

Reports

Wizards

Maps

Account Settings

Administration

Haln

(4 44

f Action Determination Review Class of Action Determin... |

Search site for_..

Saved Searches: »  Project History:

Search

-

Advanced Search My ETDM Bookmarks Logout

Review Class of Action Determination

B RIEE

#12657 PCI Testing--Issue 6

District: District 32 Phase: Programming Screen  Contact Information: tester tester  test-FD1-tester fecp-ou3®43@devnul.flz-etat.org

Class of Action Determination

Class of Action : other Actions Lead Agency

Participating / Cooperating Agencies

Environmental Impact None Federal Highway Administration

Statement

Cooperating Agendies
FL Department of Agriculture and Consumer Services
(Accepted)

Participating Agencies
Mo agencies were invited to serve as participating agencies for
this project.

All invitations to agencies are complete. You may submit a
Class of Action.

Accept the Class of Action Determination

@ Accepted ) Not Accepted (Provids Explanation Bslow)

Comments
A comment must be provided if the Class of Action is Not Accepted.

FDOT District 1 signs this class of action and submits it to Federal Highway

approval.

Bdministration for its consideration and s

Sign and Submit

By entering your password you accept the Class of Action on behalf of FDOT District 3.

User Identity Chris T. Sands @ FDOT District 3

Password ssssssss

Click to Open Map




Class of Action

Confirmation dialog when submitting COA

Message from webpage l&

I.-*’" _"”‘“-.I SIGMNATURE SUBMISSION NOTICE:

.M-. .-.-__.

You are about to submit your Class of Action signature. Please verfy
that your comments and acceptance input are correct, and click "OK"
to subrnit your signature or "Cancel” to continue editing.

Acceptance: ACCEPTED
Comments: FDOT District 1 signs this class of action and submits it to
Federal Highway Administration for its consideration and approval.




Active project: #12857 PCI Testing—Issue & - Map it Environmental Screening Tool Saved Searches: ¥  Project History:

Hide <<

Tools &
Review Project =

Coordinate ETAT =

Performance Management =

Agency Invoices =

Project Tracker=

Reports
Wizards
Maps

Account Settings

4 44 €4

Help

m Search site for__ Search

-

Advanced Search My ETDM Bookmarks Logout

Review Class of Action Determin... |
Review Class of Action Determination @ P
#12657 PCI Testing--Issue 6
District: District 3 Phase: Programming Screen Contact Information: tester tester test-FD1-tester fecp-ou3g43@devnullfla-etat.org
Class of Action Determination

Class of Action Other Actions Lead Agency Participating / Cooperating Agencies
g?:gﬁg:ntal Impact None Federal Highway Administration Cooperating Agendes

! ! ! FL Department of Agriculture and Consumer Services

(Accepted)

Participating Agencies

No agencies were invited to serve as participating agencies for -

this project.

All invitations to agencies are complete. You may submit a

; ; : Class of Action.

H h ' al
=
==

o
Class of Action Signatures &
: i . ; ] : o
; ! Review | : ! =
HName Agency | Stams | Date ETDM Role Comments ;
Chris T. ' FDOT District | ACCEFTED ' 10/21/2012 : FDOT ETDM ' FDOT District 1 signs this class of action and submits it to Federal Highway Administration =
Sands 13 1 Coordinator  for its consideration and approval.
Accept the Class of Action Determination
@ Accepted ) Not Accepted {Provide Explanztion Below) .
Comments
A comment must be provided if the Class of Action is Not Accepted.
Federal Highway accepts the Class of Action, including FDACS, a cooperating agency. »
Sign and Submit
By entering your password you accept the Class of Action on behalf of Federal Highway Administration.
User Identity Stephanie A Clemons @ Federal Highway Administration




Class of Action Report

Reports '

FProject Diary =

Advance Motification Package =

Project Effects =

Reminders =

Agency Paricipation =
Community Coordination =
FPerformance Management =
Invoicing Reparts =

Project Tracker =

Ciocument Review =

G115 Analysis Results

G115 Analysis Summary

Agency Comments - Project Effects

Agency Comments - Purpose & Need

Cumulative Effects Considerations
Report

Screening Summary Chart

Summary Report

Federal Consistency Findings

Track State Clearinghouse Projects

Report
Class of Action Determination

Comments on Envircnmental
Documents




Active project: #12657 PCI Testing—lssue & +~ Mapit
Hide << Class of Action Determination Re... |
Tools v
Reports A
Project Diary =

Advance Notification Package =
Project Effects =

Reminders =

Agency Paricipation =
Community Coordination =
Performance Management =
Invoicing Reports =

Project Tracker =

Wizards
Maps

Account Settings
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Environmental Screening Tool

Search site for_..

Saved Searches:

Search

»  Project History:

-

Advanced Search My ETDM Bookmarks Logout

Class of Action Determination Report

fod S 2R ) (2]

#12657 PCI Testing--Issue 6

District: District 3

Phase: Programming Screen

Contact Information: tester tester

test-FD1-tester fecp-ou3943@devnull.fla-etat.org

Class of Action Determination

Class of Action A(::tttrl:.s Lead Agency Cooperating Agencies Participating Agencies
Environmental Impact ' None ! Federal Highway ! FL Department of Agriculture and Consumer ' No Participating Agencies have been
Statement » Administration | Services » identified.

Class of Action Signatures
| | Review | | é
Name Agency | Status | Date ETDM Role Comments
Chris T. Sands : FDOT District 3 VACCEPTED  :10/21/2012 : FDOT ETDM ! FDOT District 1 signs this class of action and submits it to Federal Highway
» Coordinator : Administration for its consideration and approval.
Stephanie A ! Federal Highway ! ACCEPTED | 10/21/2012 : Lead Agency ETAT : Federal Highway Administration accepts the Class of Action as proposed,
Clemons : :

» Administration

: Member

»including FDACS as a cooperating agency.

Click to Open Map




Questions regarding
Participating and Cooperating
Agencies and Invitations?

Chris Sands
Mike Konikoff

help@fla-etat.org
(850) 414-5334

Pete McGilvray
peter.mcgilvray@dot.state.fl.us
(850) 414-5330




